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Purpose 

This document outlines the mechanism(s) by which Windshield District polygon areas are created prior 
to upload for consumption in the GNAHRGIS application (comprehensively referred to as the ‘Poly 
Tool’).  To complete the workflow outlined by this document, the relevant Windshield District records 
(points) referenced by these polygons , and to which these polygons are connected in order to appear in 
GNAHRGIS, must already exist in the GNAHRGIS application.  Creating those records is beyond the scope 
of this document.  Please see the relevant documentation for details regarding that process 
(https://www.gnahrgis.org/).  Additionally, this workflow assumes the user has some basic familiarity 
with the referenced software, chiefly ArcGIS Pro.   

Workflow Summary 

1. Acquire an account 
2. Install ArcGIS Pro 
3. Configure the ArcGIS Pro project 
4. Create the relevant Windshield District polygons 
5. Conflate the necessary attributes from the GNAHRGIS Application 
6. Local QC 
7. QC by HPD 
8. Cleanup 

Acquire Account 

All aspects of the Poly Tool require an active account with the GNAHRGIS ArcGIS Online organizational 
account (https://gnahrgis.maps.arcgis.com).  Please contact Stephanie Cherry-Farmer with the Office of 
Documentation and Compliance at DCA to create an account (stephanie.cherry-farmer@dca.ga.gov ).  
Once you have received confirmation of your account and have successfully logged into the GNAHRGIS 
ArcGIS Online, you should confirm the following two things about your account. 

Confirm Groups – You will need to have access to the group(s) necessary to complete your Windshield 
District polygon workflows.  Once logged in, select the ‘Groups’ tab at the top of the page.  On the 
Groups page, make sure you have the ‘My Groups’ tab selected (top of page in blue ribbon).  You should 
now see the ‘PolyTool Windshield Districts’ group in your list.  If not, send a request to your account 
administrator (above).  If you have been provided with access to the group, click on it in the list to open 
the group page.  The group will open in the ‘Overview’ tab.  As you will require the Windshield District 
polygon template dataset later in the workflow, you should download it now.  From the group page, 
select the ‘Content’ tab (blue ribbon beside the Overview tab near top of page).  To make finding the 
dataset easier, change your Content view from ‘List’ to ‘Table’.  Click on the  under the content 
tab, then on the ‘Table’ option in the popup menu.  You should now see an item in your group content 
page with the name ‘Poly Tool Template (Windshield Districts fGDB)’ of type ‘File Geodatabase’.  Click 
on the item name to open the item page.   

 

In the item page, you should see a ‘Download’ button near the top right.  Click on this to download the 
zip file to your local system for later steps.  Be sure to identify where you downloaded the zip file. It is 

https://www.gnahrgis.org/
https://gnahrgis.maps.arcgis.com/
mailto:stephanie.cherry-farmer@dca.ga.gov
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recommended that a surveyor download a clean copy of this template at the start of each windshield 
survey project, even if they have previously completed a windshield survey for HPD, in case the 
underlying schema has changed since their previous project. However, if creating polygons over multiple 
sessions during a single project, this only needs to be downloaded once at the beginning/before the 
initial session.   

Confirm Licenses – You will need to have access to ArcGIS Pro to complete your Windshield District 
polygon workflows.  Once logged in, click on your username (top right of web page) and select ‘My 
Settings’.  On the My Settings page, select the ‘Licenses’ link on the left (under My Settings).  On the 
Licenses page, you should see a list of available software to which your account administrator has 
provided access.  Scroll down if necessary until you see the ‘ArcGIS Pro’ application.  You should also see 
a download link to the right of the ArcGIS Pro name.  The next step is to download the software. 

 

Install ArcGIS Pro 

Download - To install ArcGIS Pro you must first download the software.  If you have not already done so, 
open a web browser and go to https://gnahrgis.maps.arcgis.com  Login using the account acquired in 
the previous step.  Click on your user name (top right of web page) and select ‘My Settings’.  On the My 
Settings page, select the ‘Licenses’ link on the left (under My Settings).  On the Licenses page, you 
should see a list of available software to which your account manager has provided access.  Scroll down 
if necessary until you see the ‘ArcGIS Pro’ application.  There should be a ‘Download ArcGIS Pro’ link to 
the right.  Click this to download. 

For more detail, see the following link https://pro.arcgis.com/en/pro-app/latest/get-started/download-
arcgis-pro.htm#ESRI_SECTION1_F19E35C5A28F44F69A0EA3F464A0E015 

Install – Installation of ArcGIS Pro is much like any other software and requires administrative access to 
the installation machine.  As the software has system requirements that must be met and each 
organization has varying policies and procedures regarding software installation, detailed steps are 
beyond the scope of this document.  

For more details, see the following link https://pro.arcgis.com/en/pro-app/latest/get-started/install-
and-sign-in-to-arcgis-pro.htm 

Some additional documentation links to get started with ArcGIS Pro are below 

• Online Help (also available from the software)  - https://pro.arcgis.com/en/pro-
app/latest/help/main/welcome-to-the-arcgis-pro-app-help.htm  

• Quick Start Tutorials - https://pro.arcgis.com/en/pro-app/latest/get-started/pro-quickstart-
tutorials.htm  

• Quick access toolbar - https://pro.arcgis.com/en/pro-app/latest/get-started/quick-access-
toolbar.htm  

Configure the ArcGIS Pro Project 

https://gnahrgis.maps.arcgis.com/
https://pro.arcgis.com/en/pro-app/latest/get-started/download-arcgis-pro.htm#ESRI_SECTION1_F19E35C5A28F44F69A0EA3F464A0E015
https://pro.arcgis.com/en/pro-app/latest/get-started/download-arcgis-pro.htm#ESRI_SECTION1_F19E35C5A28F44F69A0EA3F464A0E015
https://pro.arcgis.com/en/pro-app/latest/get-started/install-and-sign-in-to-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/latest/get-started/install-and-sign-in-to-arcgis-pro.htm
https://pro.arcgis.com/en/pro-app/latest/help/main/welcome-to-the-arcgis-pro-app-help.htm
https://pro.arcgis.com/en/pro-app/latest/help/main/welcome-to-the-arcgis-pro-app-help.htm
https://pro.arcgis.com/en/pro-app/latest/get-started/pro-quickstart-tutorials.htm
https://pro.arcgis.com/en/pro-app/latest/get-started/pro-quickstart-tutorials.htm
https://pro.arcgis.com/en/pro-app/latest/get-started/quick-access-toolbar.htm
https://pro.arcgis.com/en/pro-app/latest/get-started/quick-access-toolbar.htm
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Configuring the project should generally only be necessary once for each workflow.  Future updates may 
be necessary as the project evolves but shouldn’t be common.  You may of course customize your own 
project as you wish.   

Create ArcGIS Pro Project 

Open Arcgis Pro. When prompted, login with GNAHRGIS ArcGIS Online account with which you were 
provided earlier.  This will open the app to the ‘New Project’ page.  Click on the ‘Map’ option under 
‘New Project’.  This will open the ‘Create a New Project’ window.  Fill out the desired project name (e.g. 
Poly Tool Windshield Areas Create and Conflate) and the location (directory path) to create the project.  
As ArcGIS Pro projects include a number of file items, you will likely want to leave the ‘Create a new 
folder’ option checked.  A new folder of the same name will be created at the specified location.   

       

The project will now open with a new map and basemap.  At this point, you may wish to copy the zip file 
containing the polygon template you downloaded earlier from AGOL (e.g. 
GN3_WindshieldDistricts_Template.gdb.zip) to your computer’s project parent directory (the folder in 
which you are saving your project files on your local system) and unzip the contents.  You will be 
creating the district polygons in the feature class template in this extracted file geodatabase.  NOTE that 
since this workflow may require multiple ArcGIS Pro sessions to complete, depending on the number 
and complexity of polygon districts, the extracted Poly Tool template (file geodatabase) should not be 
shared with other users that may also create districts, unless they will use the same ArcGIS Pro project.  
The simultaneous use of the same project is not recommended as this will interfere with editing of the 
local Poly Tool Template layer.  However, it is fine to extract multiple copies of the Poly Tool template 
(file geodatabase) from the downloaded zip file for use across multiple projects. 

Map Configuration – This section is optional.  It is intended to provide a standardized name for your 
working map in your ArcGIS Pro project that correspond to the Polygon Creation workflow, and include 
only the necessary layers.  However, you may also just leave the default map name if you wish. 

Polygon Creation Map:  Rename the default map created by the project from ‘Map’ to ‘Polygon 
Creation Map’.  See https://pro.arcgis.com/en/pro-app/latest/help/projects/rename-project-
items.htm for details.  The easiest method is to open the Catalog view, select the ‘Project’ pane, 
expand the ‘Maps’ section then right click on the desired map and select rename.  After entering 
the new name, this will rename the open map.  See https://pro.arcgis.com/en/pro-
app/latest/help/projects/the-project-pane.htm for more details about opening and using the 
Catalog pane. 

Add Content – Add all the layers (local and from AGOL) necessary to complete the workflow to the map 
created above.  Adding content can be done from the Catalog pane or using the ‘Add Data’ tool under 
the ‘Map’ tab on the main ribbon. This document assumes the latter.  

     

https://pro.arcgis.com/en/pro-app/latest/help/projects/rename-project-items.htm
https://pro.arcgis.com/en/pro-app/latest/help/projects/rename-project-items.htm
https://pro.arcgis.com/en/pro-app/latest/help/projects/the-project-pane.htm
https://pro.arcgis.com/en/pro-app/latest/help/projects/the-project-pane.htm
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Before adding the local Poly Tool Template layer, it will be useful to add the file geodatabase in 
which it resides (e.g. GN3_WindshieldDistricts_Template.gdb) to your list of project databases.  This 
will make it simpler to find in the future.  In the Catalog pane (to the right of the map ((Note: If this 
is not showing, you’ll need to go to the main ribbon above the map, select the “View pane,” and 
then click “Catalog Pane” in the main ribbon. The Catalog Pane should appear at the right side of 
your map.)), under the Project tab, right click the ‘Databases’ section and then click ‘Add Database’.  
In the ‘Select Existing Geodatabase’ window that opens, browse to the location of the template file 
geodatabase you unzipped earlier (e.g. GN3_WindshieldDistricts_Template.gdb), select it and hit 
‘Ok’.  This geodatabase will now appear in your list of project databases.   

It will look like this in your Catalog Pane: 

 

• Add Poly Tool Template layer - On the Map ribbon, click the ‘Add Data’ tool, click “Data” (the 
first selection in the drop-down),  then in the pop-up window, click on the ‘Databases’ section 
under ‘Project’ (in the table of contents on the left).  You should see the file geodatabase you 
just added to your list in the right window pane.  Double click to open, select the 
‘GN3_WindshieldDistricts_Template’ feature class and click ‘Ok’.  The layer is added to your 
map.  NOTE that the map coordinate system will adjust to the first layer added (in this case 
GSC_WGS_1984, the template’s coordinate system).  It is always preferable to edit in the native 
projection of the editable dataset. 

 
• Add Layers from AGOL – The following layers are available from the GNAHRGIS AGOL account.  

To add these, open the ‘Add Data’ window.  Under the ‘Portal’ (1) section (see image below), 
select the ‘My Groups’ (2) subsection.  If the ‘Content’ (4) tab is selected, change it to ‘Groups’ 
to view your groups.  Then find and select (double click) the ‘PolyTool Windshield Districts’ 
group.  This will list the content items in the group.   Select the following list of items (Ctrl to 
select multiple) and click ‘Ok’ in the ‘Add Data’ window.  The items should be added to your 
map.  Save your ArcGIS Pro project. 

o Poly Tool Windshield Districts Centroid Layer – This contains the source points in the 
GNAHRGIS database from which you will conflate the necessary attributes to your local 
polygons.  NOTE that the layer name will appear as Windshield District Centroids in the 
map 

o Poly Tool Layers for Windshield Districts – This contains two layers, a duplicate of the 
centroid layer above (i.e. Windshield District Centroids) and the existing polygons 
already in the GNARHGIS system (i.e. Windshield Districts).  It is only intended for use as 
an additional reference during polygon creation. 
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Other Data Layers:  You may determine there are other layers (local or web) that can help inform 
your polygon creation.  Any of these can be added to the map as well.  Some example sources are 
below. 

• State Imagery (6-inch) – The State GIO’s office can provide access to high resolution imagery for 
the state.  See http://gio.ga.gov/state-imagery-program/ for details on accessing the imagery.  
NOTE that this data is intended for state agencies, you would need to work with the state GIO’s 
office if you wish to provide access to external contractors.  Also be aware of the vintage of this 
data, currently, it is circa 2015-2017. 

You’ll know that layers have been successfully added by looking at your “Contents” window to the left: 

 

Configure Layer Settings – Before beginning polygon creation, there are some layer settings that should 
be set.  These are outlined below. 

Symbology – You may configure symbology on any FEATURE layer in a map.  Sources from ‘Map 
Image Layers’ and basemap raster layers cannot be altered in ArcGIS Pro.  See 
https://pro.arcgis.com/en/pro-app/latest/help/mapping/layer-properties/symbolize-feature-
layers.htm for more details 

Field mappings – To use the Transfer Attribute tool to conflate attributes from the Poly Tool 
Windshield Districts Centroid Layer to your new polygons (Poly Tool Template), you will need to 
configure the field mappings correctly in the Editor Settings in the map you plan to use for this 
activity (e.g. Polygon Creation Map).  The attribute field map is available on the Edit tab, in the Tools 

http://gio.ga.gov/state-imagery-program/
https://pro.arcgis.com/en/pro-app/latest/help/mapping/layer-properties/symbolize-feature-layers.htm
https://pro.arcgis.com/en/pro-app/latest/help/mapping/layer-properties/symbolize-feature-layers.htm
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group from the dialog box launcher, and in the Transfer Attributes tool pane by clicking the Editor 
Settings button Menu .  See https://pro.arcgis.com/en/pro-app/latest/help/editing/configure-
field-mapping.htm for additional details.   

• Select the ‘Edit’ tab on the ribbon 
• Under the ‘Tools’ group, find the ‘Transfer Attributes’ tool and select it 
• This will open the ‘Modify Features’ pane with the ‘Transfer Attributes’ tool.  Select the Editor 

Settings button Menu (in the top-right hand corner of the pane) to open the Field Mapping 

context menu. Click on the context menu to open the Editor Settings window. 
• Set the field mappings as below between your source (i.e. Windshield District Centroids) and 

target (Your Poly Tool Template) layers.  DO NOT set a field mapping for Shape.  Click Ok (see 
the image below for field mapping settings) 

• Save the ArcGIS Pro project 
 

 

 

Create Polygons 

The polygon creation process will occur in your Polygon Creation Map and uses standard ArcGIS Pro 
tools and workflows.  See https://pro.arcgis.com/en/pro-app/latest/help/editing/get-started-
editing.htm for more details.  You will want to focus on the ‘Manage layer editability’, ‘Create features’ 
(in particular, the ‘Polylines and Polygons’ section), and ‘Modify features’ sections.   

To modify a polygon once created, one easy method is to use the “Modify Vertices” tool. See 
https://pro.arcgis.com/en/pro-app/latest/help/editing/modify-feature-vertices.htm . Under the edit 
tab, click “Modify” in the “Features” pane. In the right-hand window, click “Edit Vertices.” You can then 
use the pop-up tools that appear at the bottom of the map to add and subtract vertices (to round out a 
line segment), or click on a vertices to move it.  

Be sure to SAVE your edits regularly as you work. 

Transfer Attributes 

Attribute transfer will occur in your Polygon Creation Map.  This process can occur during polygon 
creation (i.e. after each polygon has been created) or once all polygons have been created.  To Transfer 

https://pro.arcgis.com/en/pro-app/latest/help/editing/configure-field-mapping.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/configure-field-mapping.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/get-started-editing.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/get-started-editing.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/modify-feature-vertices.htm
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attributes, use the Transfer attributes tool for which you previously set the field mappings.  You will 
need to confirm that both the source (i.e. Windshield District Centroids) and target (Your Poly Tool 
Template) layers are selectable and the target layer is editable in the map before transferring attributes 
between layers (see https://pro.arcgis.com/en/pro-app/latest/help/mapping/map-authoring/contents-
pane.htm ; https://pro.arcgis.com/en/pro-app/latest/help/editing/specify-which-layers-can-be-
edited.htm for information on how to confirm this). With field mappings and layer settings correctly set, 
using the Attribute Transfer tool to conflate attributes is as simple as selecting a source feature (it will 
flash) and then a target feature (will also flash) in sequence.  See  https://pro.arcgis.com/en/pro-
app/latest/help/editing/transfer-attributes-between-features.htm for more details and using the tool. 

NOTE that while the field mappings themselves should be saved when you save the project, you 
must reset the source and target layers for each ArcGIS Pro session. 

Be sure to SAVE your edits regularly. 

QC 

At minimum, the QC steps below should be carried out on the data.  This list is not necessarily 
comprehensive as it is difficult to predict (or identify) all potential errors in a free form workflow.  

• Confirm the polygon geometry correctly represent their respective areas 
• Confirm the polygon attribution represents the correct GNAHRGIS record.   

o BoundaryId – As this value links the polygon to the GNAHRGIS application, it is of 
particular importance that the value conflated to each polygon represent the correct 
record in the GNAHRGIS database.  Additionally, BoundaryId values in the local polygon 
dataset must be unique across all polygon records.  If they are not, it means a 
GNAHRGIS record has been conflated to multiple polygons and this MUST be corrected 
before upload. 

HPD QC 

HPD will QC and upload the polygons created in the Poly Tool Template.  To do this, you must deliver the 
file Geodatabase (i.e. GN3_WindshieldDistricts_Template.gdb) that contains the Poly Tool template 
dataset you edited (i.e. GN3_WindshieldDistricts_Template) to HPD.  Please ZIP the file Geodatabase 
before transfer.   

Please name the file the title of the survey in GNAHRGIS. Send the file via email to survey@dca.ga.gov or 
contact survey@dca.ga.gov to arrange a file transfer if the file size is too large for email.  

Cleanup 

Clean up the local poly layer to prepare it for the next cycle of polygon updates.  You will simply replace 
the dataset with a new empty copy of the original template.  This is mainly to start with a fresh dataset 
for each project or survey.   

• Close out all instances of ArcGIS Pro.   
• Backup the file geodatabase if desired (i.e. move the fGDB to another location or rename it) 

using standard OS tools (e.g. Windows File Explorer).  

https://pro.arcgis.com/en/pro-app/latest/help/mapping/map-authoring/contents-pane.htm
https://pro.arcgis.com/en/pro-app/latest/help/mapping/map-authoring/contents-pane.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/specify-which-layers-can-be-edited.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/specify-which-layers-can-be-edited.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/transfer-attributes-between-features.htm
https://pro.arcgis.com/en/pro-app/latest/help/editing/transfer-attributes-between-features.htm
mailto:survey@dca.ga.gov
mailto:survey@dca.ga.gov
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• Move a copy of the Poly Tool Template file geodatabase to the same location as your previous 
run.  Now when you reopen your ArcGIS Pro project, it will point to the new empty dataset. 


